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1. Introduction

This course has been made for the scaffolding package of SCIA Engineer. In this package the
following modules are included:

Module Description

esa.00 1D member modeller

esa.01 Planar 2D members

esa.06 Productivity toolbox

esas.29 Surface load generators
esas.00 Linear statics 2D

esas.01 Linear statics 3D

esas.07 Tension only members

esas.08 Pressure only support of soil
esas.09 Nonlinear springs, gaps

esas.42 Friction springs

esas.10 Geometrical nonlinear of frames
esas.13 Stability analysis of frames
esasd.01.01 Steel code check — EN 1993-1-1
esasd.13.01 Scaffolding checks - EN 12811-1
esadt.0l Automated GA drawings

If other modules are necessary to perform a specific action described in this manual, it will be
indicated.



2. Model

General

The objective of this manual is to show a way of modelling a scaffolding (class 3) using SCIA Engineer.
In this manual a simple example is elaborated.

The following scaffolding will be treated in this course:

When entering the project, the following project data are chosen:

Frame XYZ

Project Level: Advanced
Material: S235

National Code: EC-EN

and the following functionalities:
Non-linearity (+ all options for non linearity on the right hand side)

Scaffolding
Stability



Materials

For the materials, S235 is generally used. However, floor boards and toeboards will be inserted as
members. The average weight of these toeboards and floor boards differs from the weight of S235.
That is why it is chosen to insert an extra material in SCIA Engineer, in which the weight will be

adapted. This weight can be determined as shown below:

FLOOR BOARDS

A distinction is made between floor boards of 19cm and 32cm. For each of them an average weight

is calculated:
Name Weight Length [kg/m] Average
[kg] [m]
Steel board 23.2 3.07 7.56
32/307
Steel board 19 2.57 7.39
32/257
Steel board 15.7 2.07 7.58
32/207
Steel board 12.2 1.57 7.77 8.20
32/157 kg/m
Steel board 10.8 1.4 7.71
32/140
Steel board 10.4 1.09 9.54
32/109
Steel board 7.2 0.73 9.86
32/73
Steel board 18.2 3.07 5.93
19/307
Steel board 15.5 2.57 6.03
19/257
Steel board 12.7 2.07 6.14 6.18
19/207 kg/m
Steel board 10 1.57 6.37
19/157
Steel board 7 1.09 6.42
19/109

It is assumed that the floor boards have a thickness of 1 cm (instead of 4 cm to reduce the stiffness).

The weights of the floor boards are:

= Floor boards 0.32m: p =

= Floor boards 0.19m: p =

0,32m-0,04m

0,19m-0,04m

8,2kg/m

8,2kg/m

= 640,6 kg/m3

=1079,0 kg/m3




Cross sections

Below all cross sections used in the construction are displayed:

Cross section Material
Standard R0O48.3x3.2 S235
Ledger R0O48.3x3.2 S235
Guardrail R0O48.3x3.2 S235
Bracing R0O48.3x2.3 S235
Floor board — 0.32m RECT (40; 320) FB 0.32
Floor board — 0.19m RECT (40; 190) FB 0.19
Tube R048.3x3.2 S235
n Crnss-Sectio:i.-' - - ﬂ
Air Bk Gl @ A * ¥
[Ystandard - RO482:32 TR | tandard iy
& Ledger - RO48.33.2 T RO48.3X3.2 =
& Guardrail - RO48.3X3.2 P Thinowalled U
% Bracing - RO48.3X2.3 Shape type in-walled

% FB0.32 - Rectangle (40; 320}
FE 019 - Rectangle (40; 190)
Tube - RO48.3%3.2

=l Source and Type descriptio...

Source description
Type description
= Parameters
Material
Circular hellow sections

Profile Library filter

Stahl im Hochbau / 14.Auflage ...

Circular hollow section

5235
RO48.3%3.2

All cross-sections

‘ Mew " Ingert || Edit " Delete |

[l

| Setup ‘ Update all | Close |

-~

Construction - linear

The construction will be entered as a 3D Frame for the first level. Afterwards this level is copied
upward. The type of all members in this frame is entered correctly:

- Columns: column

- Ledgers: beam

- Bracings: vertical wind bracing

- Hinges
- Supports



FLOOR BOARDS

The input of floor board elements depends on the length of the ledgers. In the picture below all the
possibilities are displayed. The total length of the ledger is shown at the bottom. The distance of the
points, on which the floor board has to be entered, is displayed at the top.

BRACINGS

The wind bracings are entered with an eccentricity in the y direction of 48.3 mm (width of the profile): ey
=+/- 48.3mm. This way the wind bracings are truly on top of the other members and not in between:

/
4
L/, ,

\

Without eccentricity With eccentricity

CONNECTIONS

Standard — Standard connections

The overlap length between two columns is 200 mm > 150 mm, so the columns are rigid in the x -
direction.

Moreover, the margin between two columns is 3.9 mm (=48.3 mm — 2 x 3.2 mm — 38 mm), this is
less than 4 mm. Because of this, also the connection in the y and z direction are rigid.
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According to the code, also the following applies:

= According to code EN12811-1, the connection column - column can be considered rigid
in the modelling
= A hinge will not be entered at the extremities on the standard

Standard — Toeboard and Ledger — Floor board connections

- ydirection;: Hinged
-z direction: Rigid
Standard — Bracing connections
- ydirection: Hinged
- zdirection: Rigid
Standard-Ledger and Standard—Guardrail connections

Or input a certain flexibility in the two directions, for example:

- ydirection: 0,20 MNm/rad
-z direction: 0,005 MNm/rad

These rigidities are obtained from data from the supplier. In this case, the rigidity for the y direction is
taken from the supplier and a smaller value is taken for the z direction. Of course, this is not a
correct method. Both should be obtained from data from the supplier.

Or choose a “hinge” from our library in SCIA Engineer:

"T Scia Engineer 14.0.76 - [Esal : 1]

o File Edit View | Libraries | Tools Meodify Tree Plugins Setup Window Help
i
DS H |9 || B vt L enmOE SGLE 0,
: 7y 0% 00 03 G Ly EE Cross-sections rx Y 1 :l - =
== Setup
Strudure H Catalogue blocks 0 x E
B B named item |
; L‘—Jm 10 Member Structure, Analysis M| BE]  Cross-section list
g S Steel P | 083 section matrix
Eeam .
_%[I Column ﬁ] Concrete, reinforcement 5 Fabricated Css, Product range, Joists
E 1D member ¢ @) Subsail, foundation == Monlinear fundtions
E]"% 2D Member Loads 3 |® Hinge type
[~ Load panel )
-0 Ad\ranpced Input B Fire neat (il mitial deformations
E]"E Model data Heat transfer Il Bucking
'=" Check structure Drawing tools Orthotropy
Bl Modelling/Draw| g | u14rinutes definition
&[] Edit of solids
N - - . .




.

1’ Hinge type

MName

ux

uy

Stiff - uy [MMN/m)]

uz

fizx

fiy

Stiff - fiy [MNm/rad]
Fun - fiy

fiz

Stiff - fiz [MMm,/rad]

Material
Picture

ek [kN]
Wk [kM]
Wzk [kMN]
ke [lem]
Whyk [kMm]
Mzk [kiMm]

Hinge type Layher Variante K2000+ -

K2000+

Rigid ~
Flexible -
4 8500e+00

Rigid ~
Rigid -
Monlinear ~
7,6680e-02

Layher K2000+ - My =
Flexible ~
5,1000e-03

Right angle coupler
Friction sleeve
Swivel coupler
Base jack

Parallel
General

Cuplok coupler

Layher Variante K2000+
Layher Variante II
Layher Variante HS

And input this hinge on all ledgers and guardrails.

For those hinges the linear stiffness is input already. The principle about the non linear stiffness will be
explained later in this course.

Properties X

Hinge on beam (181) [«|\@ V. #
X

Hinge type Library -

Hinge type library K2000+ T

Paosition Both -

wux Rigid

uy Flexible

Stiff - uy [MM,/m] 4 8500e+00

uz Rigid

fize Rigid

fiy Monlinear

Stiff - fiy [MNm,/rad)] 7,6680e-02

Fun - fiy Layher K2000+ - My

fiz Flexible

Stiff - fiz [MNm,/rad] 5,1000e-03
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SUPPORTS

There are two types of supports: the base jacks at the bottom and the anchorages in the wall.

For the base jacks, translations in all directions are fixed (Translations X, Y and Z fixed). For the
anchorages, only the translations according to the x and y direction are fixed (Translations X and Y
fixed).

The anchorages are introduced according to the anchorage scheme: from 4m high, every standard
has to be anchored every 4 m upward. Over 20 m high, this needs to be performed every 2 m upward.

END INPUT OF CONSTRUCTION

After entering the construction, it is recommended to check the input by using the command “Check
Structure Data”. Through this function the geometry is checked on errors.

After the check, the option “Connect nodes/edges to members” is applied to the entire construction.
With this function the different parts are connected to each other.



3. Load cases and combinations

Load cases

Type of load cases in EN 12811-1
There are three main types of loads which need to be considered [EN12811-1, 6.2.1.]:
a) Permanent loads: these shall include the self weight of the scaffold structure, including all
components, such as platforms, fences, fans and other protective structures and any ancillary

structures such as hoist towers.

b) Variable loads: these shall include service loads (loading on the working area, loads on the side
protection) and wind loads and, of appropriate, snow and ice loads.

c) Accidental loads

The permanent loads are inputted as the self weight in SCIA Engineer.

The only accidental load specified in the European Standard is the downward loading on the side
protection [more info in EN12811-1, 6.2.5.1].

The variable loads can be considered as the service loads and the wind load.

The service loads are considered in Table 3 of EN 12811-1:

Table 3 — Service loads on working areas (see also 6.2.2)

Load Uniformly Concentrated load Concentrated Partial area load
class distributed on area load on area
load 500 mm x 500 mm | 200 mm x 200 mm q Partial area
o Fi F kN/m? factor
kN/m® kN kN i
P
1 0,752 1,50 1.00
2 1,50 1,50 1,00 - -
3 2,00 1,50 1,00
4 3,00 3,00 1,00 5,00 04
5 4,50 3,00 1,00 7,50 04
6 6,00 3,00 1,00 10,00 05

Each working area is capable of supporting the various loadings qi, F1 and F», separately but not
cumulatively.

d:: Uniformly distributed service load (EN12811-1, 6.2.2.2)

Each working area is capable of supporting the uniformly distributed loads, g: as specified in the
table above.

Fiand F»: Concentrated load (EN12811-1, 6.2.2.3)

Each platform unit is capable of supporting the load F1 uniformly distributed over an area of 500mm
x 500mm and, but not simultaneously, F» uniformly distributed over an area of 200mm x 200mm.

The position of each load is chosen to give the most unfavourable effect.
When a platform unit is less than 500mm wide, the load may be reduced for this unit in proportion to

its width, except that in no case shall the loading be reduced to less than 1,5kN.
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gz: Partial area load (EN12811-1, 6.2.2.4)

This load has to be applied only for classes 4, 5 and 6. In those cases each platform is capable of
supporting a partial area loading g2 on an area Ag2:

Agpp=1"w-a,

With:
I The length
w The width
ap Coefficient of Table 3

The dimensions and position of the partial area are chosen to give the most unfavourable effect. One
example is shown below:

M max; 6: max V max
{ l

axl axl

©- - -©- -
| 7 . = = | v = =

- ©- -©- -

axl axl
b'<a, xw: o =1

1 M'
a Xws<b'<w: od=a_ X—
P r bv

Wind load

Following 6.2.7.4 of EN12811-1, two wind loads have to be calculated: the maximum wind load and the
working wind load.

Maximal wind load

When the European Standard for wind loads is available it is used for the calculation of the maximal
wind load.

To make allowance for equipment or materials which are on the working area, a nominal reference
area is assumed at its level over its full length. This area is 200mm and includes the height of the
toeboard. (En 12811-1, 6.2.7.4.1)

Note: For the purposes of structural design of facade scaffolds made of prefabricated components,
design velocity pressures are given in EN 12810-1, 8.3.

11



Working wind load

A uniformly distributed velocity pressure of 0,2 kN/mz2 is taken into account.

To make allowance for equipment or materials which are on the working area, a nominal reference
area is assumed. This area is 400mm and includes the height of the toeboard. (En 12811-1, 6.2.7.4.2)

Area of wind loading

The wind load is inputted as an area load. The amount of this load, depends on the amount of the
loaded area itself, so without cladding a smaller wind load will be inserted than with cladding or netting.

Load cases in SCIA Engineer

The following load cases will be inputted in SCIA Engineer:

Load Case 1: Self Weight

In this load case the complete self weight of the structure is included, including the toeboards, floor
board elements, ...

This load case is automatically calculated by SCIA Engineer.

Load Case 2: Self Weight of the toeboards (and other structural members)

The self weight of the toeboards can be calculated as follows:

Surface area of the profile = 15 cm x 2 cm = 30 cm2 = 30 x 104 m2
Density of the toeboard = 773.3 kg/m3

Weight of the toeboard per meter = 30 x 10*m?2 x 773.3 kg/m3 = 2.32 kg/m

Line load: 2.32 x 9.81 N/m = 22,76 N/m = 0,023 kN/m

Load Case 3: Service load work condition

This load case represents the service load that operates over the entire main floor. “Main floor”
means the most important/crucial floor of the scaffolding. If the load is put on this floor, it leads to the
most critical values.

In this example, a class 3 scaffolding has been inserted, so a divided load of 200 kg/mz2, or 2 kN/m?
(EN12811-1 Table 3). This is transferred to floor boards.

Analogous above, also a service load is entered on the complete secondary floor. Secondary floor
refers to the working area at the first level above or below the main floor.

According to the code EN12811-1, 50% of the service load has to be put on the secondary floor.

Load Case 4: Service load Max wind

This load case represents an accumulation of materials and equipments for the complete main
working area, when the scaffolding is subject to the maximal wind load.

12



Note

In some cases it can be necessary to input a non symmetric load on the construction. So it can be
important to input a load case, completely analogous to load case 3, 4 or 5, but here the service load
is only put on half of the main floor. By executing this load case, the structure is eccentrically loaded,
so effects that counterbalance each other in a symmetrical load, are revealed here.

Example:

Full loaded

Half loaded

Load Case 5: Maximal Wind load Perpendicular to Facade

Since the arithmetic method for the calculation of a wind load from code EN12811-1 is not valid for
all scaffoldings, provided by nets that completely surround the construction, the code EN 1991-1-4 is
adopted.

There are three cases for calculating a reference height (EN1991-1-4, Figure 7.4)

building  reference shape of profile
face height of velocity pressure
b
e
1 z=h Gx(2)=a,(z.)
h< b h
I z
b
e
o F z=h qp(2)=q,(h)

Yy

ZC:b —

[
x =h
t % a,(2)=0,(h) R
b >
h hstripI TZQ:Zsmp qp(z)-qp(zs”)g"
=b
2 4,(2)=0,(b)
b
z
' 1
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In the example discussed in this course, the height is 11m and the building face is 12,35m. So in this
case clearly 11m < 12,35m and thus h < b. So the wind only has to be calculated for ze =11m.

In this example, the wind is calculated for a construction without nets, situated in Belgium with a
terrain category of Ill.

The terrain category is determined as follows (EN 1991-1-4, Table 4.1):

Terrain category Zo[M] | Zmin [M]
0 Sea or coastal area exposed to the open sea 0,003 1
I Lakes or flat and horizontal area with negligible vegetation and 0,01 1

without obstacles

Il | Area with low vegetation such as grass and isolated obstacles (trees, 0,05 2
buildings) with separations of at least 20 obstacle heights

i Area with regular cover of vegetation or buildings or with isolated 0,3 5
obstacles with separations of maximum 20 obstacle heights (such as
villages, suburban terrain, permanent forest)

v Area in which at least 15% of the surface is covered with buildings 1,0 10
and their average height exceeds 15m

For Belgium, vbo equals 26.2m/s following the EC-EN. In addition Cdir and Cseason are all equal to 1.
From this vb can be calculated (EN 1991-1-4 (4.1)):

Vb = Cdir : Cseason : Vb,0

=26,2m/s

In terrain class Ill the mean velocity vm are calculated using the following formula (EN 1991-1-4
(4.3)):

Vm = Cr(Z)-CO(Z)'Vb

where
Co(2) is the orography factor taken as 1,0 (unless specified otherwise in EN 1991-1-4 84.3.3.)

and ci(z) is the roughness factor given by formula (EN 1991-1-4 (4.4)):

For <7<
7 2. <1<1
c,(z) =k, -In(—j e i

Z

Cr (Z) = Cr (Zmin) for zZ< Zmin

14



0,07
And k, = 0,19[2—0]
Zon (EN 1991-1-4 (4.5))

The evaluations of these formulas for this example and category Il gives:

0,07 0 3 0,07
k=019l 2| =019 2| =0,215
0,05

Zy

¢, (z) =k, - In(i] =0,215- |n(%] ~0,776

And the mean velocity:

v, =¢,(2)-¢,(2) Vv, =0,776-1-26,2 = 20,3m/s

Out of these values the peak velocity pressure is calculated by:
1 2
45(2) =C(2) -Gy =, (2) 5 -V}

where

p =1,25 kg/m3
¢ (2)=[+7-1,@)] (c,(2) - (c,(2))

fi
N

C,(2)- In( : J
Z0

Iv(z) = Iv(zmin) for z< Zmin

<7<7,,

min

ki is the turbulence factor. The recommended value for ki is 1,0.
These formulas evaluated for this example and category Il gives:

1,(2) = d 10 =0,278

z) 11
Co(2)- In(zol 10- In[mj

c.(2)=[1+7-1,(2)]-(c,@)) - (c,(2)f =[1+7-0,278]-(0,776)* - (1,0)* =1,77

That way, the total external pressure is obtained by:

q,(2) =¢,(2) -%-p-vs =1,77-%-1,25- (26,2)°N /m2 = 760N / m2 = 0,76kN / m2

15



Furthermore, we can assume that the members in the plane perpendicular on the wind load take up
about 1/5 (=20%) of the total surface of the construction, as shown on the drawing below:

20% of the total pressure is entered on the walls. This equals a total maximal wind pressure of 0.76
kN/m2 x 0.2 = 0.152 kN/mz,

Code EN 12811-1 86.2.7.4.1.:

To make allowance for equipment or materials which are on the working area, a
nominal reference area shall be assumed at its level over its full length. This area
shall be 200 mm high measured from the level of the working area and includes the
height of the toeboard. The loads resulting from the wind pressure on this area
shall be assumed to act at the level of the working area.

In this example, the toeboards are already calculated in the “20% of the total surface”:

In this example the toeboards are 150mm high. The area of EN12811-1; 86.2.7.4.1 is 200mm so it is
necessary to calculate with an extra height of 50mm (200mm-50mm) due to equipment of the
working area. 50mm high on a total length of 2m (= 2000mm) corresponds to 2.5% (=50/2000).

So the wind pressure is: 0.152 kN/m2 + (0.025 x 0,76kN/m?2) = 0.17 kN/mz2.

Note 1

When inputting netting on the structure the following procedure can be taken into account to calculate the
wind pressure on the structure (Netting = 50%):

- Calculate the wind force
- 50% of the wind will be stopped by the netting and carried by the first columns
- 20% of the other 50% of this wind will be inserted on the first plane

- 20% of the other 50% of this wind will be inserted on the second plane

Note 2
In this paragraph the wind has been calculated as a wind pressure. In EN 12810-1a calculation with wind

forces instead of wind pressures. The difference of this method with the EN 1991-1-4 will be discussed in
Annex A.

16



Load Case 6: Maximal Wind load Parallel to Facade

In an analogous way, the Maximal Wind load is entered parallel to the facade on the structure.

Also here maximal wind pressures of 0.17kN/m2 are entered.

Load Case 7: Working Wind load Perpendicular to Facade

The code EN12811-1 prescribes that if the scaffolding is into service, it only needs to be loaded with
the so-called working wind load.

This working wind load is calculated analogously to the Maximal Wind load on the scaffolding, but a
reference wind pressure of 0.2 kN/m? is assumed.

The calculation is done analogous to the maximal wind pressure, only the reference wind pressure of
0.429 kN/m2 (=26,2m/s) from item “Load Case 8” is now replaced by 0.2 kN/m?:

EN 12811-1 §6.2.7.4.2:

A uniformly distributed velocity pressure of 0,2 kN/m2 shall be taken into account. To make
allowance for equipment or materials being on the working area, a nominal reference area
as defined in 6.2.7.4.1, but 400 mm high, shall be used in calculating working wind loads.

d,(z) =c.(2)-0,2kN/m2 =177 -0,2kN / m? = 0,354kN / m2

The toeboards in this example are 150 mm high. In total an extra height of 250 mm (= 400mm —
150mm) is calculated with. This corresponds to 12.5% of the total construction (= 250/2000).

Subsequently, the wind pressure is multiplied by 20% (total surface of the members) and 12.5% (due
to accumulation of material).

So the wind pressure is: 0,354 kN/m2 x (0.2+0,125) = 0,115 kN/m?2

Load Case 8: Working Wind load Parallel to Facade

In an analogous way, the working wind load is entered parallel to the facade on the structure. In this
case, the wind pressures are also 0.115 kN/m2.

Combinations

Principle of combinations EN 12811-1

Following EN 12811-1, 6.2.9.2 the load cases have to be combined in two different ways: the service
condition and the out of service condition

In each individual case the service condition and the out of service condition shall be considered.
a) The service condition consists of:
1) The self weight of the scaffold

2) Uniformly distributed service load (EN 12811-1, Table 3, q1) acting on the working area of
the most unfavourable decked level

17



3) 50 % of the load specified in a)2) shall be taken to act on the working area at the next level
above or below if a working scaffold has more than one decked level.

4) Working wind load

b) The out of service condition consists of:
1) The self weight of the scaffold

2) A percentage of the uniformly distributed service load (EN 12811-1, Table 3, gi1) acting on
the working area of the most unfavourable decked level. The value depends on the class:

Class 1: 0% (no service load on the working area)

Classes 2 and 3: 25% (representing some stored materials on the working area)
Classes 4, 5 and 50% (representing some stored materials on the working area)
6:

3) The maximum wind load

In cases a)2) and b)2), the load shall be taken as zero, if its consideration leads to more favourable
results.

Combinations in SCIA Engineer:

With the principles described earlier in this chapter, the following load cases are made:

Combination 1: Out of service, Wind perpendicular

BG1 Self weight

BG2 Self weight toeboards

BG4 Service load max wind

BG5 Maximal wind load perpendicular with facade

Combination 2: Out of service, Wind parallel

BG1 Self weight

BG2 Self weight toeboards

BG4 Service load max wind

BG6 Maximal wind load parallel with facade

Combination 3: Into service, Wind perpendicular

BG1 Self weight

BG2 Self weight toeboards

BG3 Service load in service

BG7 Working wind load perpendicular with facade

18



Combination 4: Into service, Wind parallel

BG1

Self weight

BG2

Self weight toeboards

BG3

Service load in service

BG8

Working wind load parallel with facade

Coefficients

With the Combinations in Ultimate Limit State, a safety factor yr of 1,50 on the load cases is taken,
conformable to the code EN 12811 §10.3.2. The safety factor ymo on the material is 1,10.

For the serviceability yr and ym shall be taken as 1,00.

B | Combinations

i

A g B

) 4 | & | Input combinations

CO1 - ULS - Max Wind Perpendicular
C02 - ULS - Max Wind Parallel

C0O3 - ULS - Warking Wind Perpendicular
CO4 - ULS - Working Wind Parallel

C0O5 - 5L5 - Max Wind Perpendicular
C06 - 5L5 - Max Wind Parallel

| COT - 5L5 - Werking Wind Perpendicular
CO8 - 5LS - Working Wind Parallel

'| Mew | Ingert Edit | Delete |

Mame CO3 - ULs

Description Working Wind Perpendicular
Type Linear - ultimate

Monlinear combination -
Amplified Sway Moment method no

= |Cnntenis of combination

L1 - SW -] 1,50

LC2 - SW toeboards [-] 1,50

LC3 - Service load in work [-] 1,50

LCE - Working Wind Perpendicular [-] 1,50

| Close |

And we can change the safety factor for steel in SCIA Engineer in the National Annex:

Change ymo from 1,00 to 1,10

& Manager for National annexes

Al BBk o =& SH A

EC-EN

Austrian ONORM-EN NA
Belgian NEN-EN NA
British BS-EN NA

Czech CSN-EN NA
Dutch NEN-EN NA

B Steel setup @
EHECEN Value[-] 200,00 .
52 - Steel B ¢ @/Value)
. Member check
. -~ Fire resistance Value[-] 150,00
- Cold Formed E d (1/Value)
- - Plated structural elements Value [-] 100,00
|2 5 Member Imperfection EN1993-1-1: 5.34(3)
Bk
Lo 020

MName EC-EN

National annex Standard EN
References

= EN 1990: Basis of structural design
EN 1990 (Basis of structural design)

= EN 1991: Actions of structures

EN 191-1-3 (General actions - Snow loads)

EN 1991-1-4 (General actions - Wind actic...

= EN 1992: Design of concrete structu...

EN 1992-1-1 (General rules and rules for bu.

EN 1992-1-2 (General rules -Structural fire ...

EN 1392-2 (Concrete bridges - Design and ...

EN 1168 (Precast concrete products — Holl...

=1 EN 1993: Design of steel structures

EN 1993-1-2 (General rules - Structural fire ..

EN 1993-1-3 (General rules - Supplementar...

EN 1993-1-5 (Plated structural elements)

| Partial Safety Factors EN1993-1-1:6.1(1)

1

[ New | et | Edt | Doete |

Close |

& Gamma MO
Value [-] 110
= Gamma M1
[ 10
= Gamma M2
Value[-] 125
e o e T
= Imperfection Alpha,LT EN1993-1-1:63.22(2)
B a
Value [-] 021
B b
Value[-] 034
Bc
Value[-] 049
2d
Value [-] 076
= LTB Curves
Formula Use Table6.4

= Slenderness Limit
= Lambda LT, 0

EN1993-1-1:6.3.2.2(4)

m

Load default NA parameters

| oK I (ancell
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It is recommended to take a look at the reactions first. This way you can check the accuracy of the
imported loads and load combinations. The calculation protocol (in the result dialog) should be
reviewed as well.

The bill of material can also be found in the results menu. In this table the total length for each cross
section is shown.

With these results, each user can divide the total length of each type of cross section by the length of
one member, in order to calculate the total number of ledgers, columns, ... necessary for the
construction.

> Example

| Scaffolding.esa

1. Bill of material

Name

Bill of material

Volume
[m?]
3,0933e+00

Surface
[m?]
246,603

Mass

[kg]
3768,4

Name

Total resuks :

Material Unit mass Length Mass  Surface Unit volume
[kg/m] [m] [kgl [m?] mass
[kg/m?’]

Standard - 5235 3,6| 130,000| 462,3| 19,760 7850,0 | 5,8890e-02
RO48.3X3.2

Ledger - RO48.3X3.2__ |5 235 3,6| 206,330 733,7] 31,362 7850,0 | 9,3468e-02
Guardral - 5235 3,6| 149,660 | 532,2| 22,748 7850,0 | 6,7796e-02
RO48.3X3.2

Bracing - RO48.3X2.3 |5 235 2,6| 83,401| 2174| 12,677 7850,0 | 2,7689e-02
FB 0.32 - Rectangle FB32 8,2 | 222,300 | 1822,9| 160,056 640,6 | 2,8454e+00
(40; 320)

The results (such as normal force, moment, ...) can be viewed per profile type (columns, bracings,
ledgers). That is why it is recommended to put every cross section in different layers. This way it will
be easier to review the results per cross section type.

Apart from reviewing the results, the anchorage forces have to
i be checked as well. These can be found in “Reactions”:
F7
2"
! 1,?8
T
15
5
Lo 75
B s 10
17
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5. Scaffolding SLS Check — EN 12811-1

The deformation check in SLS is a part of EC3. According to the code EN1281-11 the allowable
deformation is L/100. This limit value is set as follows:

Steel -> Setting => Setting of the Relative Deformation => Bring all values to 100

-
B Steel setup

[=] EC-EM

E- Steel
Member check

- Fire resistance

-+ Cold Formed

- Plated structural elements

- Limit slenderness

- Buckling defaults

- Relative deformation

MName
= Steel

(0 = R = R = B = [ 3 B 3

Member check

Fire resistance

Cold Formed

Plated structural elements
Limit slendermness
Buckling defaults
Relative deformation
General [-]

Beamn [-]

Column [-]

Gable column [-]
Secondary column [-]
Rafter [-]

Purlin [-]

Roof bracing [-]

Wall bracing [-]

Girt [-]

Truss chord [-]

Truss diagonal [-]

Plate rib [-]

EC-EN

EN1993-1-1
EMN 1993-1-2
EM 1993-1-3
EM 1993-1-5
EM 50341-1

100,00
100,00
100,00
100,00
100,00
100,00
100,00
100,00
100,00
100,00
100,00
100,00
100,00

Load default non-MNA parameters

Load default NA parameters

| oK I Cancell

2 SLS check in SCIA Engineer

Choose for “Relative deformation” in the steel menu and check this for the Class All SLS and for the

ledgers

The maximum check will be found for beam B349: a unity check of 0,24.

The values of this check are displayed below.

21



,//’_- -_-________.-
L
.——'-----—
-—'—‘-__—-d
_——'-‘--—-—-_' o
Relative deformation
Linear calculation, Extreme : Global, System : Principal
Selection : All
Class : All SLS
Cross-section : Ledger - RO48.3X3.2
Member dx Case - combination uy Rel uy uz Rel uz Check uy | Check uz
[m] [mm] | [1/od | [mm] | [1/xx] [-1 [-1
B171 1,499 | CO8 - SLS/2 -0,2| 1/10000 -04 1/6801 0,01 0,01
B174 1,285 |CO8 - SLS/2 0,3 1/7413 -0,8 1/3208 0,01 0,03
B349 0,545 | CO7 - SLS/1 0,0 o] -2,7 1/411 0,00 0,24
B110 0,172 |CO7 - SLS/1 0,0 1/10000 0,1 1/10000 0,00 0,00
B26 0,818 | CO5 - SLS/3 0,0 1/10000 0,1| 1/10000 0,00 0,01

22




6. Scaffolding ULS Check — EN 12811-1-1

General
For a steel check the ULS combinations are used.
If necessary, the buckling settings of the members have to be checked.

It is recommended to deselect the option "Standard unbraced” in the menu “Steel -> Setting ->
Setting check steel members” for both directions.

Further settings about the buckling data can be adapted in the property window of every member, by
clicking on the three dots behind “Buckling and relative lengths".

After all the settings have been set right, the check can be performed through “Steel -> Check”. Also
here it is recommended to review the check per profile type.

This is the regular steel check that is displayed, but for scaffolding a supplementary check will be
added. This check is performed with the interaction formulae, shown below.

v .1 1.V o9
Vpl’d 3 3 VpLd
N 1 M o1 M <1
N, 10 M e v Y
Mpld 1-
Vpl,d
%<NN <1 M <1 = M =<1
Pl M, - COS 7-N
2Np|’d

According to the Eurocode, the check is only prescribed according to the left hand side table

LV
Vpl,d

<i
3

If this condition is not met, the construction has to be adapted. However, this is a very heavy check,
which is why a second column is added in SCIA Engineer, which actually comes from the DIN-code.
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Scaffolding check in SCIA Engineer

Choose for “Scaffolding Check” in the steel code check.

The maximum check will be found for beam B348: a unity check of 0,71.

Check of steel

Linear calculation, Extreme : Global

Selection : Al
Class : Al ULS

EN 1993-1-1 Code Check
EN 12811-1 Scaffolding Check
National annex: Standard EN

[Member B348 [1,090 m [RO48.3X3.2 [$235 [CO3-ULS/4 [0,71 -
Partial safety factors

Gamma MO for resistance of cross-sections | 1,10

Gamma M1 for resistance to instabiliity 1,10

Gamma M2 for resistance of net sections 1,25

Material

Yield strength fy 2350 |MPa
Ulimate strength fu [360,0 |MPa
Fabrication Rolled

Internal forces |Calculated |Unit
N,Ed -0,43 kN
Wy, Ed -0,04 kN
Vz,Ed -1,32 kN
T,Ed 0,00 kNm
My, Ed 0,91 KNm
Mz, Ed 0,01 kNm

Scaffolding check for tubular members
According to EN 12811-1& DIN 4420 Tel 1 art. 5.4.7.4 and table 7

Table of values

Npl.d 96,78 |kN
vpld 35,57 |kN
Mpl.d 1,28 kNm
Unity check N 0,00

Unity check V 0,04

Unity check M 0,71

Unity check Interaction |0,71

Unity check Max 0,71 -

The critical check is on position 0.345 m

Note: As specified in EN 12810 & 12811 the scaffolding check for tubular members
assumes the use of a 2nd order analysis induding imperfections.

Please make sure the proper settings are set or use the default EN 1993-1-1 check instead.

The member satisfies the section check.

SCIA Engineer will show you directly the scaffolding check, when choosing for the Eurocode check
for circular hollow sections, because we have activated the “Scaffolding” functionality in the
beginning of the project. If you don’t want to see the scaffolding check, but the general Eurocode
check (EN 1993-1-1), you can uncheck this option in the Steel Setup:
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—

T e W e ° =

E-EC-EN MName EC-EN =
- Steel O Steel
Member check
re resistance = Member check EMN 1993-1-1
Cold Formed = Shear EN1993-1-1:6.2.6
Flated structural elements Use A, A, instead of elastic shear [ no
mit slenderness
Buckling defaults = Torsion EN1993-1-1:6.2.7
Relative deformation Limit for torsion [-] 0,05
= Default sway types EN1993-1-1:6.31
¥y ¥ yes
-z [ no L
£ Buckling length ratios ky, kz EN1993-1-1:6.3.1 I
Mazx. k ratio [-] 10,00
Max. slenderness [-] 200,00
2™ order buckling ratios Acc. to input »
= Lateral Torsional Buckling EN1993-1-1:6.3.2
Lateral torsional buckling curves General case -
Method for €1 C2 C3 ECC5119/Galea -
Method for k, EN 1993-1-1 table 6.6 -
= General settings L
Elastic verification [ no
Verify only section checks Ulne
Flexural buckling accounted for by Z"d order calculation M no
Moments on columns in simple construction [ no

Apply scaffolding check for CHS and numerical sections I no i

Reference: EN 12811-1 article 10.3.3.2, DIN 4420-1 Teil 1 Tabelle 7

Description: Setting to apply the scaffolding check for Circular Hollow Sectiens and numerical sections.

Application: When this setting is activated, a specific interaction check is executed for scaffolding sections instead of the reqular EN 1993-1-1 code
check.

This section check should be used in conjunction with a 2nd Order analysis including imperfections.

Load default non-MA parameters Load default NA parameters | oK I Cancel |
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7. Non-Linear Combinations

Overview

Global analysis aims at determining the distribution of the internal forces and moments and the
corresponding displacements in a structure subjected to a specified loading.

The first important distinction that can be made between the methods of analysis is the one that
separates elastic and plastic methods. Plastic analysis is subjected to some restrictions.

Another important distinction is between the methods, which make allowance for, and those, which
neglect the effects of the actual, displaced configuration of the structure. They are referred to
respectively as second-order theory and first-order theory based methods.

The second-order theory can be adopted in all cases, while first-order theory may be used only when
the displacement effects on the structural behavior are negligible.

The second-order effects are made up of a local or member second-order effects, referred to as the P-
d effect, and a global second-order effect, referred to as the P-A effect.

P
H
-0~ -‘—
|
l X
x|
L
|
27 L
M(x) = Hx M(X) =Hx + P& + P Ax /L
_ M(L) = HL M(L)=HL+P A
First Order Theory Second Order Theory

On the next page an overview of the global analysis following the EN 1993-1-1, chapter 5, will be
given:

o Allthe rules in this overview are given in the EN 1993-1-1 art. 5. For each step the rule will
be indicated. The first rule (ocr > 10) will be explained in EN 1993-1-1 art. 5.2.1(3).

o Inthis overview 3 paths are defined:
= Path 1: In this path a first order calculation will be executed

= Path 2: In this path a second order calculation will be executed with global (and
bow) imperfections.

= Path 3: In this path a second order calculation will be executed with the buckling
shape of the construction as imperfection.

o The calculation will become more precise when choosing for a higher path.

o The lower paths will result in a faster calculation, because a first order calculation can be
executed without iterations, but this first-order theory may be used only when the
displacement effects on the structural behavior are negligible.

o Inthe next paragraphs the rules in this overview will be explained.
To take into account all non-linearity’s in the model, non-linear load combinations are made.

Furthermore, the following applies according to the code EN 12810-2:
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Design

Path 1

Path 2

stage Modular and frame systems Frame systems only
1 Tests for configurations, connection devices and components
2/3 | Calculation for each system configuration of the standard set
Determination of o ,
Continuation of path 2 only ifer . = 2;
2 if o, <2 change to path 1
3a | Analysis of the structure to determine the distribution of forces and moments using
3 Second order theory First order theory with amplification factors on the basis of
O o
3b | Analysis of the individual components and connection to verify that the resistance is adequate
One test on a representative section of a system configuration
4 Type 1 Type 2

displacement behaviour

For the verification of significant load | For the verification of o .

O . is the lowest elastic buckling load factor to be applied to the design loads

We can conclude that a second order calculation is always recommended. This second order
calculation implies to take the local and global imperfections into account, so non-linear
combinations have to be used. This principle is also shown in the following flow chart of the EN
12810-2:

Tests for configuratiens, cennection

devices, compenents

f

Choose a system

configuration First order.

for frame
systems only

First or
second
order theory

Second erder

Carry out secand aorder Carry out first order
analysis analysis

I

Apply amplification

factors
]
Apply the System
design nof
checks acceptable

fail

Repeat with
another
configuration

pass

Figure 1 — Flow diagram of the stages of the structural design

Non linear combinations are made as described in the previous chapter.
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The general procedure for the new EC-EN is shown in the following diagram.

Structural Frame Stability

5.2.1(3)
ae =10 -
es No 5.2.2(3)b 5.2.2(3)a| 5:32(11)
Global Imperfection ¢
5.3.2(6)
No Yes
Olgr 2 3 52.2(5) Ngqg > 25% Ner A Ner
[ " (member)
g if goinall
required members

2" Order Analysis

1% Order Analysis

Y
Increase sway
Yes

effects with: No Members
1 with €o

-1
Ao

A

5.2.2(3)c 5.2.2(7)b

Iy based on a global I, taken equal to L
buckling mode

Stability Check in plane
5.2.2(7)a

Stability Check out of plane + LTB Check

Section Check

With:  mer Elastic critical buckling mode.
L Member system length
Ib Buckling Length

Path 1a specifies the so called Equivalent Column Method. In step 1b and 2a “I_b may be taken
equal to L”. This is according to EC-EN so the user does not have to calculate the buckling factor =1.

In further analysis a buckling factor smaller than 1 may be justified.
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Alpha critical

The calculation of alpha critical is done by a stability calculation in SCIA Engineer. For this calculation a
Professional or an Expert edition is necessary. The stability calculation has been inputted in module
esas.13.

According to the EN 1993-1-1, 15t Order analysis may be used for a structure, if the increase of the
relevant internal forces or moments or any other change of structural behaviour caused by
deformations can be neglected. This condition may be assumed to be fulfilled, if the following criterion
is satisfied:

F, . :
. = —— = 10 for elastic analysis
FEa

With:  acr: the factor by which the design loading has to be increased
to cause elastic instability in a global mode.
Fed: the design loading on the structure.
Fer: the elastic critical buckling load for global instability,
based on initial elastic stiffnesses.

If aer has a value lower then 10, a 2™ Order calculation needs to be executed. Depending on the type
of analysis, both Global and Local imperfections need to be considered.

EN1993-1-1 prescribes that 2" Order effects and imperfections may be accounted for both by the

global analysis or partially by the global analysis and partially through individual stability checks of
members.

Global frame imperfection ¢

The global frame imperfection will be inputted for the whole structure by an imperfection value ¢. This value
can be calculated with the following formula (EN 1993-1-1 art. 5.3.2(3)a):

With: h The height of the structure in meters
. m The number of columns in a row including only those columns which carry a
vertical
. load Ned not less than 50% of the average value of the vertical load per
column in
. the plane considered.
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These inclination functions are entered through “Main -> Library -> Structure, Analysis -> Initial

deformations”:

Libraries|TooIs Modify Tree Plugins Setup Window Help

Materials h@Iﬂ@l|§ﬁ
3 Cross-sections Ei-ii. y
B s ] sz|m iR BB
. Catalogue blocks
. Mamed item

Structure, Analysis I; Cross-section list

Steel section matrix
E Concrete, reinforcement . Fabricated Css, Product range
@ subsoil, foundation B2 nonlinear functions

Loads *| & Hingetype
ﬁ Fire heat u Initial deformations

Drawing tools I Bucking
. Attributes definition & | Orthotropy

T

The Type is chosen as “According to code”, with a standard imperfection of 1/200.
The height of the construction is 11m for both inclination functions.

There are 6 columns in the X-direction, therefore the number of columns in this direction has been
inputted as “6”.

There are 2 columns in the Y-direction, therefore the number of columns in this direction has been
inputted as “2”.

The inclination function for the x-direction (Def_X) in SCIA Engineer is displayed below:

-
B | Initial deformations ﬁ
AHeBK Q& ESHE A - ¥ |
Mame DefX
Type EN1993-1-1 art. 5.3.2(3) -

Basic imperfection value:1/[-] 200,00

Height of structure : [m] 11,000

MNumber of columns per plane: 5

©: 0,00254600

ot [-] 0,67

O i [-] 0,76

| New ” Insert " Edit " Delete | | Close |
.

All combinations are entered four times, once with the inclination according to positive x and once
according to positive y and negative x and negative y:
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# ' Menlinear combinations ’ =

o L @& A -

NC1 Mame MNC1

NC2 Description

NC3 Ul .

MCA Type timate
I NC5 = Contents of combination

MNCE LC1 - SW -] 1,50

NCT LC2 - SW toeboard 1,50

NCB - toeboards [-] .,

Mg LC4 - Service load max wind [-] 1,50

NC10 LC5 - Max Wind Parallel with Facade [-] 1,50

NC1L Bow imperfection J -

NC12 P

MC13 Global imperfection -

NC14 f X

NC15

1/f 200

NC16 .

NC1T7 = dx inclination functions

NC19 Factor MNone -
I NC20

NC21 Sense + -

MC22 Y Mone -

:E;i = dy inclination functions

NC25 z Mone -
I MC26 X Mone -

NE27 =l dz inclination functions

NC28 X N B

NC29 one

MC30 Y Mone -

NC31

NC32

| New from linear combinations || New || Insert || Edit || Delete | | Close |

Initial bow imperfection eo

The initial bow imperfection is given by:

AN Buckling curve | elastic analysis | plastic analysis
acc. to Table 6.1 g/ L g/ L
ag 1/350 1/300
a 1/300 1/250
b 1/250 1/200
c 1/200 1/150
, o | d 1 /150 1 /100

Where L is the member length.

The buckling curve used for calculation of the imperfection is the curve inputted in the cross-section
library. For standard sections, the curve according to the code is automatically used, for non-
standard cross sections (as general cross sections) the user needs to input the buckling curve
manually.

Where L is the member length.
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The bow imperfection has to be applied when the normal force Neq in @ member is higher than 25% of
the member’s critical buckling load Ner.

SCIA Engineer can calculate the bow imperfection according to the code automatically for all needed
members. But in a scaffolding structure all profiles have the same buckling curve and thus the same

bow imperfection. This bow imperfection is inputted as “simple curvature”: the same curvature for all

members.

-
B | Monlinear combinations ' ﬂ

Al eBE|ID & A - ¥
MC1 Mame MNC1
NC2 Description
he3 Ultimat -
NCA Type imate
MC5 = Contents of combination
NC6 LCL-SW -] 1,50
NCT LC2 - SW toeboard 1,50
NCE - toeboards [-] .
NC9 LC4 - Service load max wind [-] 1,50
I NC10 LC5 - Max Wind Parallel with Facade [-] 0
N2 imperfect .
NC12 Bow imperfection Simple curvature
MC13 Global imperfection atioh Tu o -
MNC14 f 0,005
MNC15
200
MNC16 Uf
NC17 = dx inclination functions
MNC18 z Defx -
NC19 Factor MNone T
MNC20
MC21 Sense + -
MC22 Y Mone -
Egﬁ = dy inclination functions
NC25 z Mene .
|| MC26 X Mane -
NC27 = dz inclination functions
NC28 X Maone -
MNC29
MNC30 ¥ Mone -
MNC31
MNC32
New from linear combinations || New || Insert || Edit || Delete | Close
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8. The second order calculation

Timoshenko

The first method is the so called Timoshenko method (Th.II.O) which is based on the exact
Timoshenko solution for members with known normal force. It is a 2" order theory with equilibrium on
the deformed structure which assumes small displacements, small rotations and small strains.

When the normal force in a member is smaller than the critical buckling load, this method is very solid.
The axial force is assumed constant during the deformation. Therefore, the method is applicable when
the normal forces (or membrane forces) do not alter substantially after the first iteration. This is true
mainly for frames, buildings, etc. for which the method is the most effective option.

The influence of the normal force on the bending stiffness and the additional moments caused by the
lateral displacements of the structure (the P-A effect) are taken into account in this method.

This principle is illustrated in the following figure.

P
"ot
-0 T
l
! "
= |
L
|
777 i
M(x) = Hx M(X) =Hx + P& + P Ax /L
M) =HL M(L)=HL + P A
First Order Theory Second Order Theory

The local P-8 effect will be regarded further in this course.

If the members of the structure are not in contact with subsoil and do not form ribs of shells, the finite
element mesh of the members must not be refined.

The method needs only two steps, which leads to a great efficiency. In the first step, the axial forces
are solved. In the second step, the determined axial forces are used for Timoshenko’s exact solution.
The original solution was generalised in SCIA Engineer to allow taking into account shear
deformations.

The applied technique is the so called ‘total force method’ or ‘substitution method’. In each iteration

step, the total stiffness of the structure is adapted and the structure is re-calculated until convergence.
This technique is illustrated in the following diagram.
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Calculate K¢

Solve Ku=F

No

Convergence
inu?

Yes

)

In this figure, the stiffness K is divided in the elastic stiffness Keg and the geometrical stiffness Kg. The
geometrical stiffness reflects the effect of axial forces in beams and slabs. The symbol u depicts the
displacements and F is the force matrix.

The criterion for convergence is defined as follows:

Z(uazc,i + ujzl,i + ugz) - Z(uazc,i—1 + ui,i—1 + ug,i—l)

2 2 2
Z(ux,i + uy,i + uz,i

< 0,005/(precision ratio)

With: Ux,i The displacement in direction x for iteration i.
Uy,i The displacement in direction y for iteration i.
Uz, The displacement in direction z for iteration i.

This convergence precision (Precision ratio) can be adapted in the solver setup:
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- -
B Solver setup lﬂ

Mame
= Solver
Run one nonlinear combination
Meglect shear force deformation ( Ay, Az »>> A)
Bending theory of plate/shell analysis Mindlin -
Type of solver Direct -
Mumber of thicknesses of rib plate 20
Murnber of sections on average member 10
Warning when maximal translation is bigger than [mm] 1000,0
Warning when maximal rotation is bigger than [mrad] 100,0
Print time in Calculation Protocol v
= Nonlinearity
Maximum iterations 50
Geometrical nonlinearity - Iand 1L order Timoshenko -
Mumber of increments 1
Eorees |
Coefficient for reinforcement 1
=l Stability
Mumber of critical values 4

a=imra=] |-—0K—{ Cancel }—

The choice of the Timoshenko Method and the maximal amount of iterations can be specified through
Calculation, Mesh > Solver Setup.

Newton Raphson

The second method is the so called Newton-Raphson method (Th.III.O) which is based on the
Newton-Raphson method for the solution of non-linear equations.

This method is a more general applicable method which is very solid for most types of problems. It can
be used for very large deformations and rotations; however, as specified the limitation of small strains
is still applicable.

Mathematically, the method is based on a step-by-step augmentation of the load. This incremental
method is illustrated on the following diagram:
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l A

Uu=up+Au

No

Convergence
inu?

In this figure, the tangential stiffness Kt is used. The symbol u depicts the displacements and F is the
force matrix.

The original Newton-Raphson method changes the tangential stiffness in each iteration. There are also
adapted procedures which keep the stiffness constant in certain zones during for example one
increment. SCIA ENGINEER uses the original method.

As a limitation, the rotation achieved in one increment should not exceed 5°.

The accuracy of the method can be increased through refinement of the finite element mesh and by
increasing the number of increments. By default, when the Newton-Raphson method is used, the
Number of increments is set to 5 and the number of 1D elements is set to 4 in the mesh setup.

In the Mesh setup we also advise to deactivate the option “Generation of nodes in connections of beam

elements”.
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[ B | Mesh setup @1

Mame

*

=l General mesh settings

Definition of mesh element size for panels Manual -
Average size of panel element [m] 1,000
Elastic mesh W

Uze autematic mesh refinement
= 1D elements
Minimal length of beam element [m] 0,100

m

Maximal length of beam element [m] 1000000

Generation of nodes in connections of beam elements

Generation of eccentric elements on members with variable height

Division on haunches and arbitrary members 5

Division for 20-1D upgrade 50

Mesh refinement following the beam type Only 20 members .
Method of haunch export Constant parts -

El 2D elements
To generate predefined mesh W

-

a=im™3nl=] Ok Cancal [

When this option is activated, beams will be connected by the nodes they are going through. But when
4 nodes are inputted on the beams, it could happen that a node has been inputted in the middle of a
diagonal and another diagonal is crossing this one in the program and now they are connected. To
avoid unwanted connections, we advice to uncheck this option.

In some cases, a high number of increments may even solve problems that tend to a singular solution
which is typical for the analysis of post-critical states. However, in most cases, such a state is
characterized by extreme deformations, which is not interesting for design purposes.

The choice of the Newton-Raphson Method, the amount of increments and the maximal amount of
iterations can be specified through Calculation, Mesh > Solver Setup.
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r -
B " Solver setup Iﬁ

Mame

El Solver
Run cne nonlinear combination
MNeglect shear force deformation ( Ay, Az > A)

Bending theory of plate/shell analysis Mindlin -
Type of solver Direct -
MNumber of thicknesses of rib plate 20

MNumber of sections on average member 10

Warning when maximal translation is bigger than [mm] 1000,0

Warning when maximal rotation is bigger than [mrad)] 100,0

—

Nonlineanty
Maximum iterations 50
Geometrical nonlinearity - I.and I order MNewton-Raphson

MNumber of increments 5

Solver precision ratio

Coefficient for reinforcement 1
= Stability
MNumber of critical values 4

__‘@ i QK I'I Cancel '_

As specified, the Newton-Raphson method can be applied in nearly all cases. It may, however fail in
the vicinity of inflexion points of the loading diagram. To avoid this, a specific method has been
implemented in SCIA Engineer: the Modified Newton-Raphson method.

Also when the Newton-Raphson method is failing, there is the possibility of the method of Picard.

This method follows the same principles as the default method but will automatically refine the number
of increments when a critical point is reached. This method is used for the Non-Linear Stability
calculation and will be looked upon in Chapter 7.

In general, for a primary calculation the Timoshenko method is used since it provides a quicker solution
than Newton-Raphson due to the fact Timoshenko does not use increments. When Timoshenko does
not provide a solution, Newton-Raphson can be applied.
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9. Stability

Linear Stability

During a linear stability calculation, the following assumptions are used:
- Physical Linearity.
- The elements are taken as ideally straight and have no imperfections.

- The loads are guided to the mesh nodes, it is thus mandatory to refine the finite element mesh in
order to obtain precise results.

- The loading is static.
- The critical load coefficient is, per mode, the same for the entire structure.

- Between the mesh nodes, the axial forces and moments are taken as constant.

The equilibrium equation can be written as follows:

[KE - KG]' u=F
The symbol u depicts the displacements and F is the force matrix.
As specified in the theory of the Timoshenko method, the stiffness K is divided in the elastic stiffness
Ke and the geometrical stiffness K. The geometrical stiffness reflects the effect of axial forces in
beams and slabs.
The basic assumption is that the elements of the matrix K¢ are linear functions of the axial forces in the
members. This means that the matrix K corresponding to a A™ multiple of axial forces in the structure

is the At multiple of the original matrix K.

The aim of the buckling calculation is to find such a multiple A for which the structure loses stability.
Such a state happens when the following equation has a non-zero solution:

[K.—4-Ks]u=0

In other words, such a value for A should be found for which the determinant of the total stiffness matrix
is equal to zero:

Ke—4-Kg =0
Similar to the natural vibration analysis, the subspace iteration method is used to solve this eigenmode

problem. As for a dynamic analysis, the result is a series of critical load coefficients A with
corresponding eigenmodes.

To perform a Stability calculation, the functionality Stability must be activated.
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Project data @

Basic data | Functionality | Actions Protection
@ SCIA | Dynamics + [ |E [Steel |

Initial stress Fire resistance
Subsail Connection modeller
Nonlinearity Frame rigid connections
v Frame pinned connections
Cliratic loads Grid pinned connections
Prestressing Bolted diagonal connections
Pipelines Expert system

I Structural model = Connection moenodrawings
BIM properties Scaffolding
Parameters LTE 2nd Order
Mobile loads ArcelorMittal

I Automated GA drawings

LTA - load cases
External application checks

Property modifiers
Bridge design

| OK | | Cancel |

In the results menu, the A values can be found under the caption #|} Ciical load coefficients
The number of critical coefficients to be calculated per stability combination can be specified under
Setup > Solver.

Note:

- The first eigenmode is usually the most important and corresponds to the lowest critical load coefficient. A
possible collapse of the structure usually happens for this first mode.

- The structure becomes unstable for the chosen combination when the loading reaches a value equal to the
current loading multiplied with the critical load factor.

- A critical load factor smaller than 1 signifies that the structure is unstable for the given loading.

- Since the calculation searches for eigen values which are close to zero, the calculated A values can be both
positive or negative.

A negative critical load factor signifies a tensile load. The loading must thus be inversed for buckling to occur
(which can for example be the case with wind loads).

- The eigenmodes (buckling shapes) are dimensionless. Only the relative values of the deformations are of
importance, the absolute values have no meaning.

- For shell elements the axial force is not considered in one direction only. The shell element can be in
compression in one direction and simultaneously in tension in the perpendicular direction. Consequently, the
element tends to buckle in one direction but is being ‘stiffened’ in the other direction. This is the reason for
significant post-critical bearing capacity of such structures.

- Initial Stress is the only local non-linearity taken into account in a Linear Stability Calculation.
- It is important to keep in mind that a Stability Calculation only examines the theoretical buckling behaviour

of the structure. It is thus still required to perform a Steel Code Check to take into account Lateral Torsional
Buckling, Section Checks, Combined Axial Force and Bending, ...
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Manual calculation of Kg

The principle of a stability calculation and the meaning of the matrix K¢ will be explained with a simple
example:

Suppose the next situation:

Rigid Bar
<— N
I'(E
NN
| L |

This beam with length L has a pinned support at the left and a flexible spring support at the right with
rigidity: Ke.

Two point loads are inputed on the beam: a vertical R and a compression force N.

Standard analysis says that R and N are independent (in the un-deformed configuration) and the
stiffness relationship is:

KE r = R
With r the vertical translation of the right point of the beam.

But, if the structure is allowed to deform, we can calculate equilibrium in the deformed configuration as
shown below:

R
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Summing moments about the pinned end we get:
R-L+N-r=S§-L
The equation for the response of the springis: Kg-r =S
Substituting S we get:
R-L+N-r=(Kg-r)-L
Dividing by L:
R+ % ‘r=Kg-r
And grouping terms we have:

= (k=)

This can further be re-written if we define the geometric stiffness as:

N
KG —_ Z
giving the final form as:
R = (KE - KG) T

When the normal force N is multiplied with a factor acr S0 that the total rigidity becomes zero:

acg N

K_
E L

=0

The structure will buckle and become “unstable”.

Buckling Shape

As an alternative to Global and Local imperfections, paragraph 13. Non linear combinations allows
the use of a buckling shape as a unique imperfection.

To input geometrical imperfections, the functionality Nonlinearity > Initial deformations and
curvature and Stability must be activated.
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Project data - ‘ léj

Basic data |Functionality Acdtions Protection

#SCIA | Dynamics | |¥ |Nonlineanty | =
Initial stress Initial deformations and curvat.. ¥
Subsoil 2nd order - geometrical nonlin... ¥
Monlinearity W Bearn local nonlinearity v

W Support nonlinearity/Soil spring |V
Climatic loads Friction support/Soil spring v
Prestressing Membrane elements =
Pipelines Press only 2D members
Structural model E General plasticity
BIM properties Sequential analysis
Parameters El Steel
Mahbile loads Plastic hinges
Automated GA drawings Fire resistance —
LTA - load cases Connection modeller
External application checks Frame rigid connections
Property modifiers i Frame pinned connecticns
Bridge design Grid pinned connections

oK | | Cancel

The calculation of the buckling shape through a stability calculation will be looked upon in Chapter 7.

Since the buckling shape is dimensionless, Eurocode gives the formula to calculate the amplitude minit
of the imperfection. In Ref.[29] examples are given to illustrate this method. In this reference, the
amplitude is given as follows:

— Ncr
Tinit =€ E.| E M
ly ncr,max
2
20
=a-(A-02) 8. Twi_ o 75072
Nepe 1- x- (1)2
with: A= |Ne
cr
o= The imperfection factor for the relevant buckling curve.
X = The reduction factor for the relevant buckling curve, depending on the

relevant cross-section.

Nrk = The characteristic resistance to normal force of the critical cross-section, i.e.
Npt,Rk.

Ner =  Elastic critical buckling load.

Mrk = The characteristic moment resistance of the critical cross-section, i.e. Mel,rk
or Mel,rk as relevant.

ne =  Shape of the elastic critical buckling mode.

ngrmx = Maximal second derivative of the elastic critical buckling mode.
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The value of ninit can then be entered in the field Max deformation.

# | Ncnlinear combinations ﬁ
HiaeBBE| o =& A - 5
NCL [Name NCL
Description
Type Ultimate v
E Contents of combination
LC2 - Load 1194 76 kM [-] 1,00
Bow imperfection Mone -
Global imperfection Buckling shape =
Stability 51 -
Eigen shape 1
Max deformation [rmm] 56
Mew from linear combinations " Mew " Insert || Edit " Delete | ‘ Close ‘

2 Example Stability Imperfection.esa
In Chapter 6, the use of the buckling shape as imperfection according to EC3 was discussed. In this
example, the procedure is illustrated for a column.

The column has a cross-section of type RO48,3x3,2, is fabricated from S235 and has the following
relevant properties:

E =210.000 N/mm? fy = 235 N/mm?2 ym1 = 1.00
L =2000 mm A =453 mm?2
ly = 116000mm* Wiy = 6508,8 mm?3
o
=1
N
~ Y |
o)
O
O
(@]
d
— T AKX

Calculation of the buckling shape
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First a Stability calculation is done using a load of 1kN. This way, the elastic critical buckling load Ner
is obtained. In order to obtain precise results, the Number of 1D elements is set to 10. In addition, the
Shear Force Deformation is neglected so the result can be checked by a manual calculation.

The stability calculation gives the following result:

Critical load coefficients

N f

- [l

Stability combination : S1
1 |60,11

This can be verified with Euler's formula using the member length as the buckling length:

7Bl 7 -210.000N/ o .116000mm’

N = 2 2
I (2000mm)

=60105,89N

The following picture shows the mesh nodes of the column and the corresponding buckling shape:

o
<
|

Displacement of nodes

Stability calculation, Extreme : No

Selection : Al

Stabiity combinations : 51/1 - 60,11

Buckliing shapes are dimensionless, units are printed for consistency purposes.

Node of mesh Case Ux Uz Fiy
[mm] | [mm] | [mrad]

1 51/1 - 60,11 0,0 0,0 1000,0

11 S1/1-60,11 196,7 0,0 951,1

3 S1/1-60,11 374,2 0,0 809.0

4 S1/1-60,11 515,0 0,0 587.8

5 S1/1-60,11 605,5 0,0 309,0

& S1/1-60,11 636,6 0,0 0.0

7 S1/1-60,11 605,5 0,0 -309,0

8 S1/1-60,11 515,0 0,0 -587.8

9 S1/1-60,11 374,2 0,0 -809,0

10 S1/1-60,11 196,7 0,0 -951,1

2 S1/1-60,11 0,0 0,0] -1000,0

Using for example an Excel worksheet, the buckling shape can be approximated by a 4t grade
polynomial.
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A polynomial has the advantage that the second derivative can easily be calculated.

=17, =L42E7"° x* -5, 70E~" x* +7,55E"° x* +9,88E " X
= Mo max =L70E % x* —3,43E™° x+151E ™

Calculation of e

Ng = f, x A=235N/, x 453mm?2 = 106455 N
Mg = f, xW,, =235N/ % 6508 8mm® = 1529568 Nmm

7_ N _ [106455N _
A=V N, = Voo110N = 138

o =0,21 for buckling curve a

1

051+ a7 -02)+ (1) [+ V08 + o -02)+ (2f | - G

These intermediate results can be verified through SCIA ENGINEER when performing a Steel Code
Check on the column:

y= =0,45
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Buckling parameters Yy Frd

Sway type sway non-sway
System length L 2,000 2,000 m
Buckling factor k 1,00 1,00

Buckling length Lcr 2,000 2,000 m
Critical Euler load Mcr 60,11 60,11 kI
Slenderness Lambda 124,98 (124,98

Relative slenderness Lambda,rel 1,33 1,33
Limit slenderness Lambda,rel,0 0,20 0,20

Buckiing curve a a
Imperfection Alpha 0,21 0,21
Reduction factor Chi 0,45 0,45
Buckiing resistance Nb,Rd 48,27 48,27 kI
—\2
1— X (/1)
— M 152 N
Sy =a-(1-02) Mac._ Tw__g2q.(133-0.0). DE2ENMM
Neo 1— 4. (z) 106455N
=3,41 mm

The required parameters have now been calculated so in the final step the amplitude of the
imperfection can be determined.

Calculation of 7init
The mid section of the column is decisive = x = 1000

1. at mid section = 636,6

77(:r,max

. L 03
at mid section = 1,57E }{nmz

= =e,- Ne:
Minit = €0

E.| e

y Ter max

60110N

=3,41mm -
! N/ . 4 157E°
210000\, -116000mm* -1,57E° L/,

-636,6

=3,42 mm
This value can now be inputted as amplitude of the buckling shape for imperfection.

To illustrate this, the column is loaded by a compression load equal to its buckling resistance.
However, due to the imperfection, an additional moment will occur which will influence the section
check. The buckling resistance can be calculated as follows:

AT, N
Ngg = Nypg =5—— =045 453mme- 235N/ =47,90 kn

7M1

A non-linear combination is created in which the buckling shape as imperfection is specified.
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# ' Monlinear combinations ﬁ
KL 4 e} = >
NC1 [Name NC1
Description
Type Ultimate ~
= Contents of combination
LC2 - Load 47,9kM [-] 1,00
Bow imperfection Mone ~
Global imperfection Buckling shape A
Stability 51 -
Eigen shape 1
Max deformation [mim] 34
| Mew from linear combinations " Mew || Insert " Edit " Delete | | Close |
e ——————————————————————

Using this combination, a non-linear 2"® Order calculation is executed using Timoshenko’s method.

The additional moment can be easily calculated as follows:

1 1
M n,init = NEd *Minit 1_—NEd = 47'90kN . 0,00342m : ]__MW
N 60,11kN

cr

= 0,80 kNm

When performing a Steel Code Check on the column for the non-linear combination, this can be
verified. The critical check is performed at 1m and has the following effects:

wiiSECTION CHECK::...

The critical check is on position 1.000 m

Internal forces |[Calculated |Unit

N,Ed -47,90 kN
vy, Ed 0,00 kN
vz,Ed 0,04 kN

The additional moment thus corresponds to the moment calculated by SCIA Engineer.
As seen in the diagram, Path 3 is followed: the buckling shape serves as a unique global and local

imperfection. This implies that only a section check and Lateral Torsional Buckling need to be checked.
Since LTB is negligible with this small bending moment, only a section check is required:
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Scaffolding check for tubular members

§2 According to EN 12811-1:2003,art. 10.3.3.2 and equation 9
~r
|
‘ Table of values
N Yy | Npl.d 106,46 | kN
b vpl.d 39,13 |kN
Mpl.d 1,41 kKMNm
5 Unity check N 0,45
= Unity check V 0,00
o Unity check M 0,57
f Unity check Interaction |0,75
Al Unity check Max 0,75 -
RN TL%X The member satisfies the section check.

This example has illustrated the use of a buckling shape as imperfection. Depending on the geometry
of the structure, this imperfection can have a large influence on the results due to the additional
moments which occur.

When using this method, it is very important to double check all applied steps: small changes to the
loading or geometry require a re-calculation of the buckling shape and amplitude before a non-linear
analysis may be carried out.

As a final note: the buckling shape only gives information about a specific zone of the structure. The
imperfection is applied at that zone and results/checks are only significant for that zone. Other
combinations of loads will lead to another buckling shape thus to each load combination a specific
buckling shape must be assigned and a steel code check should only be used on those members on
which the imperfection applies. Since the applied buckling shape corresponds to a global mode, failure
of these members will lead to a collapse of the structure.
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Input Hinge Types and non-linear stiffness

Couplers

General principle

For connections in a scaffolding structure, a check has to be performed on the normal forces, the
shear forces and the moments. Various connection types are inserted in SCIA Engineer. For the
different connections, go to “Libraries -> Structure, Analysis -> Hinge type”.

Libraries i Tools Modify Tree Plugins Setup  Window Help
B Materiais @Hﬂ@l!l%ﬁl
i Cross-sections : B E’t, B
. Setup

. Catalogue blocks
4 . Mamed item
| Structure, Analysis » Cross-section list

Steel r Section matrix

E Concrete, reinforcement . Fabricated Css, Product range
B subsoil, foundation | Hinge type
g Loads * [l initial deformations

ﬂ Fire heat IE Buckling

| Drawing tools »

L8 Attributes definition

In this “Hinge type library” you can choose following types at the option” Hinge type”:

Right angle coupler Friction sleeve Swivel coupler
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Base jack Parallel General Right angle continuous
coupler

In this connection, not only the rigidities are entered in a flexible or non-linear way, but specifically for these
connections, the maximal allowable forces can also be inserted, as displayed below for the Right angled
couplers:

,

P R I e &I - A - ¥
K2000+
Mame K2000+
ux Rigid ~
uy Rigid w7
I uz Rigid -
fine MNonlinear ~
Stiff - fix [MMNm,/rad] 7,5000e-03
Fun - fix RA-B-ME e
fiy Monlinear ™
Stiff - fiy [MNm/rad] 1,5000e-02
Fun - fiy RA-B-MB e
fiz Nenlinear =
I Stiff - fiz [MNm/rad] 7,5000e-03
Fun - fiz RA-B-MT e
Hinge type Right angle coupler ~
Material Steel -
Mre
Mk [kN] 15,00
ik [kN] 30,00
Vak [kN] 15,00
Whcke [kMm] 013
Wyk [kMNm] 0,80
Mazk [kMNm] 013
New Insert Edit Delete [m]
. —

The rigidities are filled out and the maximal forces have to be obtained from the info of the connections,
provided by the supplier.
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Manual input

In this example, a connection of Layher is being adopted (K2000+):

r\

=

For this connection, it is advisable to enter a general connection containing the properties of Zulassung Z-
8.22-64. For this purpose, the following maximal forces are displayed:

My,rd =111 kNcm (=1,11 kNm)
Mzrd =41 kNcm (=0,41 kNm)
Vy,rd =11 kN

VzRrd = 29,04 kN

Nbrd = 34,1 kN

o [rad] = M/(9140 — 73,6M)

The equation above for the rotation gives the following rotation curve:

120
100

80 /
60 /
wl
20 /

-

0 0,01 0,02 0,03 0,04 0,05 0,06

M [kNcm]

@ [rad]
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To enter this correctly, it should be performed using a non-linear spring or a non-linear function in SCIA
Engineer:

[

- - 3
i " Nonlinear functions u
A emh| o = 8 B> Roson ‘
RA-B-MT -
RA-B-MB
Cuplok-Msx
Cuplok-My
Layher K2000+ -Mx
I Layher K2000+ - My i
|
Mame Layher K2000...
Type Rotation
Positive end Free -
MNegative end Free -
= Impulse o
1 [rad,kNm] -0,0562 /-1,00 L::
00246 /-080 | [— L1 I
2 [rad, kMNm] | /-0, T T T e i :,\‘—'\“‘ ﬁ [rad
3 [rad,kNm] -0,0127 / -0,60 = =
4 [rad,kNm] -0,0065 / -0,40 -
5 [rad,kNm] -0,0026 7 -0,20
6 [rad,kNm] 0,0026 /0,20
7 [rad,kNm] 0,0065 /0,40 100
& [rad,kNm] 0,0127 /0,60 I
9 [rad,kNm] 0,0246 /0,80
10 [rad,kMm] 00562 /1,00
Create new function " New " Insert " Edit | Delete OK
e —

If everything is being filled out in the values for this hinge, the following dialog appears:

B 7 Hinge type library ‘ | P .n
AlpeBEk o S SH A - Y

K2000+

|I Name K2000+
ux Rigid ) i
uy Flexible - L
Stiff - wy [MN/m] 4 8500e+00
I uz Rigid ~ ]
fix Rigid *
fiy Nonlinear hd
Stiff - fiy [MNm/rad] 7,6680e-02
Fun - fiy Layher K2000+ -1~ ..
fiz Flexible hd
Stiff - fiz [MNm/rad] 5,1000e-03
Hinge type Layher Variante K200 -
Material Steel hd
Picture
Mk [IeM] 3410
Vyk [kN] 11,00
II Vzk [kN] 25,04
Wk [kMm] 0,58
Myl [kMm] 111
Mzk [kMNm] 041

New Insert Edit Delete Close
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It is assumed that the translations are “rigid” in all directions. Also the rotation around the x-axis is
considered as “fixed”. This is only a rough estimate. For the rotation around the y-axis, the non-linear

function (determined earlier) is entered with a linear rigidity of 0,051 MNm/rad. The rotation around the local
z-axis will be much smaller than around the y-axis namely 0,0051 MNm/rad.

For the values of Vyk, the same value is taken as for Vy.. This value should be determined by the supplier as

well.

For the maximal moments the same conclusion can be drawn.

Subsequently these hinges are attributed to both extremities of the ledgers and guardrails.

Couplers in SCIA Engineer

Some couplers are input already in SCIA Engineer:

Cuplock coupler

Layher Variante K2000+

Layher Variante Il

\ ""J_T— /
I
|
I
|
|
Name Varlll =
ux MNonlinear - MName Warlll
SHff - wx [MN/m] 4,3640e+01 ux Rigid
Fun - ux Cuplok-N i uy Flexible
uy Rigid - Stiff - uy [MN/m] 4,8500e+00
uz Rigid - uz Rigid
fix Monlinear - fixc Menlinear
Stiff - fix [MNm/rad] 1,8270e-02 SHff - fix [MMm/rad) 1,3876e-03
Fun - fix Cuplok-Mx .. Fun - fix Layher K2000+ -«
fiy Monlinear = fiy Nonlinear
SHiff - fiy [MNm/rad] 6,5000e-02 E Stiff - ﬂ.y [MMNm/rad] 7,6680e-02
Fun - fiy Cuplok-My - Fun - fiy Layher K2000+ - My
fiz Flexible _ fiz Flexible
Siff - fiz [MNm/rad] 2.5000e-03 Stiff - fiz [MNm/rad] 5,1000e-03
| C’Uphkcoupler - Layher Variante K2000+
Material Steel - Material Steel
" b Picture
Picture | ok (1] "
S s z Vyk [kN] 11,00
ik [kN] 0,00 g Vo 6] 08
Vzk up [kN] 1815 R M ] g
Vzk down [kM] .78 Wik i) i
M [ktim Lo - Mz [kNm] 041

MName

[

uy

SHiff - uy [MN/m]

uz

fine

fiy

SHiff - fiy [MNm/rad]
Fun - fiy

fiz

Stiff - fiz [MNm/rad]

Varlll

Rigid
Flexible
4,8500e+00
Rigid

Rigid
MNonlinear
1,2800e-01
Layher Il - My
Flexible
5,1000e-03

Hinge type Layher Variante I

Material
Picture
Mk [kN]
Wyk [kN]
Wzk [kN]
Mk [kMm]
Myk [kNm]

Mazk [kMm]

Steel

2497
731
19.14
0,00
0,75
041
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Layher Variante HS

ux Rigid

uy Nonlinear

Stiff - uy [MN/m] 8,3330e-01

Fun - uy Layher Variante HS - Vi
uz Rigid

fix Monlinear

Stiff - fix [MNm/rad] 24620e-03

Fun - fix Layher Variante H5 - Mx
fiy Nenlinear

Stiff - fiy [MNm/rad)] 1,1560e-01

Fun - fiy Layher Variante HS — My
fiz MNonlinear

SHiff - fiz [MNm/rad] 1,0000e-02

Fun - fiz Layher Variante H5 - Mz

Material
Picture
ek [kN]
Vyk [kN]
Vzk [kN]
Mxk [kNm]
Myk [kMNrm]
Mzk [kNrm]

Steel

38,61
18,26
4,87
0,58
132
044
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Non linear gaps for bracings

For the connection between the wind bracings and the columns, the rotation around the local y-axis is free.
There can be a discussion about the rigidity around the z-axis. In this example, it is set on “rigid”, although it
cannot be completely considered as “rigid”. If you want to enter the exact value, you have to ask the supplier.

The rotation around the x-axis and the translations in the x, y and z direction are “rigid”.

In the direction of the member (local x direction) there is a certain margin of these wind bracings. This can be

entered by adopting “Spacings”. For this purpose, all bracings are entered as a “non-linearity” on the

members, containing the type “Spacing”.

Structure o ox

m 10 Member

% 20 Member

# Load panel

L%a Advanced Input

B2 Medel data

B-Z Support

""" = Hinge on beam

----- T Rigid arms

""" X Cross-link

,:{5 Section on beam

""" S5 Connect members/nodes
""" 2L Beam - nonlinearity
== Continuous beam
Check structure data
-, Modelling/Drawing
Ll Edit of solids

-] Bill of material

=2 | M

Subsequently a margin of 1. mm per member is entered:

B ' Beam nonlinearity

el
A .

T oz

M N‘ Narme
Type

/‘ u Type

Position

I i BB
b

BM1
Gap
Both directions

Displacement [mm] 10

Begin

| P

oK |'| Cancel I_
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Non linear supports

It is also better to enter the supports as non-linear supports. In the vertical direction these supports can only
take pressure and no tension. This is entered in the z direction with “rigid press only”. The rotations are taken
free in all directions.

For the degrees of freedom according to the x and y displacements, the code prEN12812:2003, Annex B is
applied. In this, the friction coefficients between various materials are entered. If we suppose that the
scaffolding is placed on wood, we can see in this code that the maximal and minimal frictions coefficient
between wood and steel is 1.2 and 0.5. On average a value of 0.85 is adopted. This value is also entered in
SCIA Engineer.

Properties x
Support in node (1) Fl AT TS
|Name | 5nll
Type Standard -
Angle [deg]
Constraint Custom -
X Friction -
From reaction i -
C flex X [kM/m] 10000,00
mju X 0,85
¥ Friction -
From reaction z -
C flex ¥ [kM/m] 10000,00
mju Y’ 0,85
z Rigid press only -
Independent friction
R Free -
Ry Free -
Rz Free -
Default size [m)] 0,200
Mode N21
=l Geometry
Systemn GCs -

For “C flex” a large value is taken. This corresponds to a large rigidity of the support in the x- and the y-
direction before the friction is exceeded.
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11. Scaffolding Non linear Check

The results of the ULS and SLS check are repeated in this chapter, but now for the non-linear
combinations and with the correct stiffness for the connections.

Relative deformation Check (SLS)

Scaffolding.esa

- Choose for “Relative deformation” in the steel menu.

The values of this check are displayed below.

- The maximum check is found for beam B349: a unity check of 0,25.

Relative deformation
Monlinear calculation, Extreme : Global, System : Principal

Selection : Al
Class : NL 5LS
Cross-section : Ledger - RO48.3%3.2

Member dx Case - combination uy Rel uy uz Rel uz Check uy | Check uz

[m] [mm] | [1/%¢] | [mm] | [1/30x] [-1 [-]

B112 1,071 |NC7 -0,2| 1/10000 -0,2 1/10000 0,01 0,01
B174 1,285 |NC7 0,3 1/9968 -0.8 1/3030 0,01 0,03
B349 0,545 | NC8 0,0 0 -2,7 1/406 0,00 0,25
B112 0,214 |NC8 -0,1 1/10000 0,1 1/10000 0,00 0,00
BS54 0,225 |NC8 0,0 0 0,1 1/10000 0,00 0,01
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Scaffolding Check (ULS)

Choose for “Scaffolding Check” in the steel code check.

The maximum check is found for beam B347: a unity check of 0,72.

Check of steel

MNonlinear calculation, Extreme : Global
Selection = Al
Class @ ML ULS

EN 1993-1-1 Code Check
EN 12811-1 Scaffolding Check
MNational annex: Standard EM

[Member B347 [1,000 m [R048.3X3.2 [5235 [Nc4 [0,72 -

Partial safety factors

Gamma MO0 for resistance of cross-sections  |1,10
Gamma M1 for resistance to instability 1,10
Gamma M2 for resistance of net sections 1,25
Material

Yield strength fy 2350 [MPa

Ultimate strength fu |360,0 |[MPa

Fabrication Rolled

The critical check is on position 0.545 m

Internal forces |Calculated Unit
M,Ed -1,30 kM
iy, Ed 0,02 kM
vz, Ed -1,57 kM
T,Ed 0,00 kNm
My, Ed 0,92 khm
Mz, Ed 0,00 kM

Scaffolding check for tubular members
According to EMN 12811-1 & DIN 4420 Tei 1 art. 5.4.7.4 and table 7

Table of values

Mpl.d 96,78 |kN
vpl.d 35,57 |kN
Mpl.d 1,28 kMm
Unity check N 0,01

Unity check V 0,05

Unity check M 0,72

Unity check Interaction |0,72

Unity check Max 0,72 -

The member satisfies the section check.
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12. Scaffolding — Coupler Check

Checking the internal forces

When checking the allowable stresses, it is recommended to view the results per profile type

(standards, bracings, ...). The maximal stresses can now be compared to the allowable values of the
supplier. Also the base jacks are checked with this value.

For the anchorage forces, the reaction force can be tested to the allowable force of a perpendicular
coupler. On the other hand, the anchorage can also be checked manually on the combined effect of

tension and shear.

For connections this check can be performed by SCIA Engineer itself, with the options “Steel ->

Scaffolding - Coupler check”.

Steel
EH; __I_':_ieams
-5 Steel Setup
-=3 Haunch

H- | Member Check data

This check performs a unity check for the couplers for which a maximal allowable force is given in

the coupler library:

4 S L L l

el
[ Hinge type library - "e - e -
AReBEK o Sl A AT
Varll
Narne Varlll
ux Rigid
uy Flexible
SHiff - uy [MMN/m)] 4,8500e+00
uz Rigid
fixx Rigid
fiy MNonlinear
Stiff - fiy [MNm/rad] 1,2800e-01
Fun - fiy Layher I - My
fiz Flexible
Stiff - fiz [MMNm/rad] 5,1000e-03
Hinge type Layher Variante I
i Material Steel
| Picture
Dk [kN] 2497
Wk [kN] 737
Vzk [kM] 19,14
Mk [kNm] 0,00
Myk [kNm] 0,75
Mzk [kNm] 0,41

‘ New " Insert " Edit ” Delete |

Close
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Interaction check

General couplers

Next to the check on the internal forces, also an interaction check will be executed. For a general
coupler, the following check will be shown:

Right angle coupler:

N+V, Vy My

Fsk + Fpk + MBk < 1
2— - 24—

Ym Ym YMm

Friction sleeve:

N My
JrE t e < 1
YM YM

With
Fsk Characteristic Slipping force
Taken as Nxk and Vzk of the coupler properties
2 Fsk = Nxk + Vzk
Fpk Characteristic Pull-apart force
Taken as Vyk of the coupler properties
MBk  Characteristic Bending moment

Taken as Myk of the coupler properties

N Normal force

Vy Shear force in y direction

Vz Shear force in z direction

My Bending moment about the y axis

™ Safety factor taken as ymo of EN 1993-1-1 for steel couplers

Safety factor taken as ym1 of EN 1999-1-1 for aluminium couplers

Manufacturer couplers

In addition to the scaffolding couplers listed above, specific manufacturer couplers are provided
within SCIA Engineer.

The interaction checks of these couplers are executed according to the respective validation reports.
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Cuplock

The cuplock coupler which connects a ledger and a standard is described in Zulassung Nr. Z-8.22-
208

The interaction equations are summarised as follows:

N M M
Interaction 1: Mk + M;k + Mxxk =1
YM YM M

My, (N+Nysin(a)) M,

Interaction 2: My Nek Mok <1
YM YM YM
With
Nxk Taken from the coupler properties
Myk Taken from the coupler properties
Mxk Taken from the coupler properties
N Normal force in the ledger
My Bending moment around the y-axis
Mx Bending moment around the x-axis
Ny Normal force in a connecting vertical diagonal
o Angle between connecting vertical diagonal and standard
™ Safety factor taken as ymo of EN 1993-1-1 for steel couplers

Safety factor taken as ym1 of EN 1999-1-1 for aluminium couplers

Layher Variante Il and K2000+

The cuplock coupler which connects a ledger and a standard is described in Zulassung Nr. Z-8.22-64.
Both Variante Il and K2000+ are provided.

NP M max(V,—1,4 ;0) . V
Interaction 1;  Variante II: + X+ Z Y <
Nra  MyRrd My, 25,0

N M Mt
K2000+: +—+ <1
Nra ~ MyRd My 271 MrRd

max(V,—2,1 ;0) Vy
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max(|Vg|-2,5 ;0)

| M|

Variante HS: + + +
NrRa MyRrd VzRd |My Rl
|V}’| MT 1
Vyral  Mrra —

Note: An additional check for welds is not supported

Interaction 2:

With
NR,d
MyRr,d
MzRr d
MtRr,d
VY Rrd

Vz,R,d

+)
Vy
V:
My
Mx

Nv

mA+nB)?2+ @Wwr+v8)?2 <1

Ledger A / Vertical diagonal B

NAI Y ME | fe

& Ng,g

0,707sin o N7 + cos a | Ny |

ENgg

A

v
Vc,R.G

cos « Ny
v v

z,R,d

= Nx«/ ym with Nx taken from the coupler properties
= Myk/ ym with My taken from the coupler properties
= Mzx/ ym with Mzk taken from the coupler properties
= Mxk/ ym with Mx taken from the coupler properties
= Vyk/ ym with Vyk taken from the coupler properties
= Vz/ ym with Vz« taken from the coupler properties
Normal force in the ledger

indicates a tensile force

Shear force in y direction

Shear force in z direction

Bending moment around the y-axis

Bending moment around the x-axis

Normal force in a connecting vertical diagonal

Angle between connecting vertical diagonal and standard
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e = 2,75 cm for Variante Il

= 3,30 cm for Variante K2000+

= 3,30 cm for Variante HS

eD

& = 1,26 cm for Variante I
= 1,41 cm for Variante K2000+
= 1,15 cm for Variante HS

™

= 5,7 cm for Variante Il, Variante K2000+ and Variante HS

Safety factor taken as ymo of EN 1993-1-1 for steel couplers

Safety factor taken as ym1 of EN 1999-1-1 for aluminium couplers

Scaffolding.esa

Choose for “Scaffolding — Coupler Check” in the steel menu
Take a look at the check for beam B347: a unity check of 0,47.

The values of this check are displayed below.

[/

Scaffolding - coupler check

Monlinear calculation, Extreme : Global
Selection : B347

Class : NL ULS
Verification of coupler

Name

Member position

Unity Check - Max
[-

Unity Check - Fx
[-]

Unity Check - Fy
[-]

Unity Check - Fz
[-]

Unity Check - Mx
[-

Unity Check -My
[-1

Unity Check -Mz
[-

Unity Check - Interaction
[-]

Unity Check - Interaction 2
[-]

K2000+

B347-Both(end)

ML LS

0,47

0,02
0,02
0,17

0,01
0,24
0,00

0,47
0,09

The coupler reaches a value of 0,47 for the interaction check 1, so this means for the following check

(since we were using K2000+ coupler):

N® M, max(,-21;0) V, N My <1
Nra  Mygg M, 271 Mrpq ~
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13. Aluminium

The scaffolding checks of aluminium works exactly the same as for the material steel.
Also here the checks for Circular Hollow Sections are input in SCIA Engineer and also the coupler
check has been input in SCIA Engineer for aluminium couplers.

Because everything is also possible in aluminium in SCIA Engineer, you have to indicate in the
couplers of SCIA Engineer, if they are made out of steel or out of aluminium, because this will change
the safety factor of the coupler: when choosing for the material aluminium, the safety factor will be
taken out of the National Annex of EN 1999-1-1 instead of the EN 1993-1-1:

A Hinge type library L . .'. - e @
A BB 9 &SI SHEH A - Y
Varll
Varlll
Mame Varlll
ux Rigid -
uy Flexible -
Stiff - uy [MN/m] 4,8500e+00
uz Rigid -
fie Rigid -
fiy Monlinear -
Stiff - fiy [MNm/rad] 1,2800e-01
Fun - fiy LayherII - My gl
fiz Flexible -
Stiff - fiz [MNm/rad] 5,1000e-03
Hinge type Layher Variante II -
teel -
Picture
Nk [kN] luminium
Vyk [kN] 137
Vazk [kM] 19,14
Wk [kMm] 0,00
Myl [kNm] 0,75
Mzk [kMm] 041
| Mew " Insert " Edit ” Delets | Closs
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14. Engineering Report

The scaffolding checks can be add to the Engineering Report:

avigator B X New items nx
P Check of steel - €T
P Relative deformation - [ 1. Check of steel
g Scaffolding - coupler check (.. — EC3 Monlinear calculation,
[ Special items Extreme : Global
- Inbox Selection : All
- Project Class : ML ULS
[ Libraries
[ Sets
[+ Solver and Mesh
[ Structure
[ Load Gamma M2 for resistance of net sections
[#- Construction stages Materal
B Results Yield strength [235.0  [MPa
[l Solver Files Utimate strength fu [360,0 [MPa
[ 5GB - Scaffalding Fabrication Rolled
[#- Spedial ~SECTION CHECK:...
= Steel - - .
- Check of steel The critical checkis on position 0.545 m
- Check - fire resistance | Internalforces |Calculated [Unit
Relative deformation U’Egd 516320
-~ Steel slenderness V;,’Ed 157
- Check of connection T,Ed 0,00
- Scaffolding - connection check My, Ed 0,92
Corrugated web beam check Mz,Ed 0,00

- Cellular beam checks
= Aluminium
- Check

Scaffolding check for tubular members
According to EN 12811-1 & DIN 4420 Teil 1 art. 5.4.7.4and table 7

Table of values
Relative deformation Npl.d 96,78 |kN

--5lenderness data vpl.d 35,57 [k

- Scaffolding - connection check Mpl.d 1,23 [khm
Cust heck Unity check N 0,0

ustam ched Unity check v 0,0
Pipeline Unity check M 0,72
Timber Unity check Interacton  |0,72
Concrete Unity check Max 0,72 |-

Concrete (new)

Steel concrete bridge
Geotechnics
Composite Beam
Composite Column

The member satisfies the section check.

2. Relative deformation
MNonlinear calculation, Extreme : Global, System : Principal

Selection : Al
Mobile loads Class : NL 5.5
Influence lines Cross-section : Ledger - RO48.3%3.2

Design Forms

| T T T P T T T
- E- B B B - - B - L -

? Member dx i uy uz Reluz

Special I1f0d  [mml [1fxod
Gallery pictures B112 1,071 |NCT -0,2| 1/10000 | 0,2 1/10000
[£- Report templates Bi74 1,285 |NC7 03] 1/9967 | 0,8 1/3030
B34% 0,545 [NCa 0,0 0| -27 1/406
B112 0,214 [NC8 -0,1| 1/10000 0,1 1/10000
B54 0,225 [NC8 0,0 0 0,1 110000

3. scaffolding - coupler check

Nonlinear calculation, Extreme : Global
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15. Template

To create a template, the following procedure has to be followed:

1. Create a new project or open an existing one.

2. Define all the properties and even parts of a structure that should be included in the template. If
an already existing project is used, make any changes that are necessary.

3. When you are satisfied with the result and you think that the current state of the project is what
should become the template, save it As Template using menu function File > Save As.

4. Browse for the folder where the user templates are stored - this folder is specified in the Setup >
Options dialogue.

5. Type the name of the template file.

6. Complete the action.

With this possibility, it is possible to predefine the cross sections, the (non-linear) combinations, the non
linear hinges, the document, ...

After saving a project as a template, this template can be opened just by making a New Project.
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16. User Blocks

The application of user blocks can be divided into three independent steps. The steps must be carried out in
the given order and all of them must be made.

1. Creating the user block

A user block can be created as a standard project. There are no explicit restrictions to it. Usually,
the user will be working on his/her project and either at the end or some time during the design
phase s/he decides to make a user block of the current state of the project.

Then the only thing that must be done is save the project to the disk. It may be useful, however not
compulsory, to use function Save As and give the project such a name that gives a hint about the
structure in the project.

2. Storing the user block to the library

In order to be usable as a user block, the project must be stored in the User block library folder
(see Program settings > Directory settings). This may be achieved in two ways.

e The user specifies the proper path in the Save As dialogue (see paragraph above) and
saves the project directly to the User block library folder.

e The user saves the project to his/her common project folder and then copies the file to the
User block library folder. The file may be copied in any file-management tool (e.g.
Windows Explorer, Total Commander, My Computer dialogue, etc.)

Tip: The user blocks may be stored not only in the given User block library folder, but they may be
arranged in a tree of subfolders. The subfolders may then group user blocks that have something in
common. This arrangement may lead to easier and clearer application of user blocks, especially if a
long time passes from the time they were created and stored.

When using this tip, all the subfolders can be chosen:

User blocks @

=123 User library

=1 Blokken fi. &
(3 ankers trap 4m trap
[ consoles

(12 diagonalen b ro

(11 diagonalen lo th
H-frame

(2 leuningwerk
spindel

(2 staander

(1 toren (parameters)

[ tralieligger

(12 trappen

(22 vitbouw 35cm

(11 vakken compleet

{21 verst schakel

[ vioer platform

(2 vioer staal

ChDocuments and SettingsiNeleiMy
Documents\ESA80\userblocks\Blokkenitrappenitrap 4m.ESA

Cancel
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mk:@MSITStore:C:/Program%20Files/SCIA/Engineer2008.1/ESA.chm::/html/Directories_settings.htm
mk:@MSITStore:C:/Program%20Files/SCIA/Engineer2008.1/ESA.chm::/html/Directories_settings.htm

Inserting the user block into another project using the following procedure

1. Open service Structure:
a. either by means of tree menu function Structure,
b. or by means of menu function Tree > Structure,
C. or by means of icon Structure on toolbar Project.
Select and activate function User blocks.
A User block wizard opens on the screen. Its left hand side window shows the organisation of
the User block library folder, i.e. it shows any possible subfolders. The right hand side window
then displays all available user blocks saved in the appropriate folder or subfolder.
Select the required folder.
Select the required User block.
Click [OK] in order to insert the block to the current project.
Select the required options for the import (see below).
Position the user block to the desired place and click the left mouse button to put the block
there.
9. If required, repeat the previous step as many times as required or necessatry.

wn

© N O A

Note: If the User block is a parameterised project, the program asks the user to provide all necessary
parameters in order to complete the definition of the user block.
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17. Attributes

It is possible to add attributes in SCIA Engineer and then make a “bill of material of attributes”. That
way you will have a perfect overview of the material needed for the calculated scaffold.

You can make attributes under “Tools -> Attributes definition”:

ﬁ Libraries

Uszer defined selections
Attributes definition

..... A InBlock manager

..... % cs

----- B Cleaner

----- I 1? Coordinates infa

----- X5 Convert Steel Profile Db

First you have to give your first attribute a name, for example “Ledger”.
The most easy way for scaffolds is using “Combobox”:

- -
Add new parameter ﬂ

Types of parameters - text string, number, checkbox and combobox.

Each user-attribute definition has a separate table in the Bill of material.
The first defined parameter in the user-attribute definition determines the grouping of
the attribute objects in the table,

Select type of parameter:

String Mumber

, I N
m °=4'1 ‘ I

Checkbox

[ ]

Combaobox

And now you can give the Name and description to the parameter and afterwards all possible “values”

like the length of the ledgers in this case. And the most common value could be inputted as the Default
value:
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Combobox parameter . u

Parameter — combobox

Content: name, description, possible values, default value.

Parameter name:

Ledger

Parameter description:

Ledger

(The parameter description is optional information. Itis displayed as a service tooltip.)

Possible values:

1090 ﬂ |
1570
2070
2570 s
3070
3570 ==
s | B
0| 43|
Default value:
[zE570 i

[ <Back || Fmsh | [ cancel |

This can be repeated for all the cross-section types and then the label setup can be dedefined:

I.rﬂl'l\l LEBs LS ST S L FLCLOAL (= AT N

W7 Attributes definition . - | = |
AIeBE S EHE A - 7
Ledger Mame Ledger
| Guardrail Attribute parameters
Standard [Lsbel setup |
Diaggral [More options :
Floof Attribute labeling setup g
Parameter Mame = WValue Unit Preview
Ledger r r [¥ r 2570

Now with the “Atrributes” menu the attributes can be inputted on all members, with as value the correct
length.

Wain e [
----- Project

- tH Line grid and storeys
488 BIM toolbox

-5 Structure

-4l Load

#-LZ Load cases, Combinations
EJ--- Calculation, mesh

bl Results

..... F Staal

----- [® Open connection

----- 18- Pipeline

#-sf Drawing Tools
ﬁ Libraries
EI}& Tools

AR == BE— R S = e Y B et =t |
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After inputting the attributes, you can always choose to make them invisible on the screen by the “Set
view parameters for all” via the tab “Attributes”.

And now you can have a list of all attributes in the document via “New -> Special -> Bill of material by
attributes”:

1. Bill of material

Type Hame Hame Ledger Count
Bill Ledger |Ledger |1070 42
Bill Ledger |Ledger |2570 52
Bill Ledger |Ledger |2070 13

Bill Ledger | Total 107

Type Name HName Guardrail Count
Bill Guardrail | Guardrail | 1070 GG
Bill Guardrail | Guardrail |2570 40
Bill Guardrail | Guardrail | 2070 10
Bill Guardrail | Total 116

Type Hame Hame Standard Count
Bill Standard | Standard | 2000 82
Bill Standard | Total a2

Type Hame Name Diagonal Count

Bill Diagonal | Diagonal |1,0 - 20 |16

Bill Diagonal | Diagonal |20-25 (10

Bill Diagonal | Diagonal |20-20 |5

Bill Diagonal | Total 31

Type Hame Hame Floorboards Coumnt

Bill Floorboards  |Floorboards | 2570 T2
Bill Floorboards  |Floorboards | 2070 13
Bill Floorboards | Total a0
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19. Annex A: Wind pressure versus Wind force

In paragraph “6. Load cases” the wind has been calculated with EN1991-1-4 and calculated as a wind
pressure.

Following EN 12810-1, it is also possible to calculate the wind as a wind force using the following
formula (EN 12810-1, (1)):

i=n
Fy ZCS'ZAi'Cf'qi
i=1

With

Ai is the reference area specified in EN 12810-1, Table 4 (see also below)

¢t is the aerodynamic force coefficient taken from EN 12810-1, Table 5 (see also below)
Cs is the site coefficient taken from EN 12810-1, Table 6 (see also below)

gi is the design velocity pressure in accordance with EN 12810-1, Figure 3:

30
25 -
20
15 //

10
=
/

5 -

0 /

750 800 850 500 950 1000 1050 1100 1150

25,5

height in m

pressure in N/m?

In this example, the height of the structure is 11m, so gi on 11m is + 940 N/m2 and on Om + 800 N/mz2.
When inserting one value a average of those two can be taken: 870 N/mz2.

The reference Area A

Cladding condition of the Reference area Ai
system configuration
Unclad Area of each component projected in the wind direction
Clad Surface area of the cladding (see A.3 of En 12811-1:2003)

This example was an unclad example. For a component with a diameter of 48,3mm, the area is
0,0483m X Lcomponent.

The aerodynamic force coefficient cs:

Cladding condition of the Force coefficient
system configuration Normal to the facade Parallel to the facade
Unclad 1,3 1,3
Clad 1,3 0,1
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In our example the structure was unclad. We will take a look at the force parallel to the facade, so ¢t =
1,3.

The site coefficient cs:

Cladding condition of the Site coefficient
system configuration Normal to the facade Parallel to the facade
Unclad 0,75 1,0
Clad 1,0 1,0
NOTE: The values for the site coefficients correspond to a fagcade with a solidity ratio pg= 0,4; see also EN12811-1.

For an unclad structure, the wind parallel to the fagade, results in cs = 1,0.

For each beam the force can be calculated as a line force as shown below:

- 870N N kN
FK = Cg ZA,_ ' Cf q; = 1,0 . 0,0483m : 1,3 ? = 54,6% = 0,0SSW

i=1

This load is applied on the beams shown below (the toeboards are not taken into account, because the
force coefficient is only available for tube profiles):

2ETO mm

So the total force inserted is:

= 0,055 kN/m x
E [(2+2X0,5)x 2,57m
% + (2x0,5)x 2m +3,257]
< = 0,055 kN/m (12,97m)
=0,71 kN
=
x,

In the calculation of “6. Load cases”, a load of 0,17kN/m? has been taken into account. This value
multiplied with the surface (= 2m x 2,57m) gives a total force of 0,68kN.

So the two option results in a value close to each other.
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